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The Word Environment 

Title Bar 
The 
title 

bar is the blue bar at the very top of the window.  The title bar indicates which Microsoft 
program is being used and title of the current document.  In the example below you can see that 
the title of the document is “Word Processing” and the program being used is Microsoft Word. 

Menu Bar  
The 
menu 

bar is the gray bar directly below the title bar.  The menus hold all the commands needed to 
work in word.  To find a specific command click one of the words on the menu bar, a dropdown 
menu will then appear allowing you to choose the exact command you would like to use.  It is 
important to keep in mind that word customizes its menus to your usage.  The commands you 
use most often automatically appear, those that are not used very much will remain hidden until 
you click the small arrows at the bottom of the menu.  The full menu can be seen if you double 
click on the menu. 

Toolbars 
Toolbars are located near the top of your screen, directly below the menu bar and are comprised 
of many small icons.  Each icon represents a different command.  Most of the commands on the 
toolbars can also be found in the menus but it is often quicker to use the toolbars.  There are two 
main toolbars that are shown when Word is started.  The first one, the standard toolbar, 
contains the tools for opening a new document, saving a document, printing, etc.  You can see 
what each button does when running your mouse pointer over each button, a small yellow fly-out 
box will appear displaying the command associated with the button.   

The second toolbar that is displayed upon startup is the formatting toolbar.  The formatting 
toolbar does just what it says, it allows you to format the way your text looks.  Once again, you 
can see what each of the buttons does by running your mouse pointer over each button.  
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Hidden Toolbar buttons 

Like the menu bar, the toolbars also customize to your 
usage.  The tools used most often are displayed, those not 
used are hidden.  You can see the hidden tool icons by 
clicking the small arrows on the toolbar.  As you can see 
from the example on the right, the hidden icons are 
displayed as well as an option to “Show buttons on Two 
Rows.”  If you click on that phrase the toolbars will be on two 
rows and all the tool icons will be displayed.  

To permanently change word so that the full menus and 
toolbars are always shown use the following instructions. 

1. Click Tools Menu.   
2. Click  Customize.   
3. Note A new window will open. 
4. Click “Options” tab. 
5. Click  Check box “Show Standard and Formatting Toolbars on two rows” 
6. Click  Check box “Always Show Full Menus” 
7. Click Close 

Rulers 
Along the top and to the left of your document you will see a set of rulers.  The rulers serve 
several purposes, most of which we will get into in later lessons.  At this stage in the game, all 
you really need to know is that they help you figure out where on the page your text will appear.  
The example below shows the ruler at the top of a word document.  The grayed out section of the 
ruler shows the area of your page that will be considered margins.  The white part of the ruler 
indicates the area that will contain text. 

 

Task Pane 
The task Pane is open upon Word 2003 startup.  It is a window on the right side of the screen.  
The task pane is used a lot in word.  It can help to change the formatting of text, find clip art, act 
as a Thesaurus and many other things.  We will get into the many uses of the task pane a little bit 
later.  For now, know that you can turn the task pane on or off using the following instructions. 

1. Use the Menu commands 

a. Click  View Menu 

b. Click  Task Pane. 

OR Press  Ctrl+F1.   
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Text Area 
The text area of your document is where your typing will go.  Although the text area is an 
invisible box, you can tell if you are in the text area by the way your mouse pointer looks while 
you move it.  When you have your mouse pointer in the text area you’re pointer will look like an 
I-bar.  See Appendix A for a picture of the text area.   

Selection Bar 
In Word 2003 there is a special area of the page that will help you easily select pieces of text.  
This area is called the selection bar and is located in the left margin of the page.  You can tell if 
you are in the selection bar by the way your mouse pointer appears, if it looks like a white arrow, 
you are in the selection bar.  See Appendix A for a picture of the Selection Bar. 

Insertion Point 
The insertion point is the place on the page where your text or picture will be inserted.  You 
choose the insertion point by placing your mouse pointer somewhere in the text area and 
clicking.  A small blinking line (cursor) will appear.   

Horizontal and Vertical Scroll Bar 
The horizontal scroll bar is located near the bottom of your page, the vertical scrollbar is on the 
right.  The scrollbars allow you to quickly move up and down and left and right within your 
document.  See Appendix A for a picture of the Scroll bars. 

View Buttons 
The view buttons are near the bottom of your page and allow you to see your document in 
different views.  It is important to remember that even though your document may look different, 
it is not different.  A document in print layout view will print exactly the same way it will in 
reading layout view.  See the table below for a description of each view. 

 
Normal view: shows text formatting but simplifies the layout of 
the page so that you can type and edit quickly.  
Web layout view: you can see backgrounds, text is wrapped to 
fit the window, and graphics are positioned just as they are in a 
Web browser. 

 

Print Layout View: allows you to see exactly how text will look 
on the printed page.  
Outline View: allows you to look at the structure of a document 
and to move, copy, and reorganize text by dragging headings.  

Reading Layout: modify'  

Table 1: View Buttons 
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Status Bar 
The status bar is found near the bottom of your Word 2003 screen.  It serves as a “GPS system” 
for a document and allows you to know where the insertion point is located.  

Section of  
document 
insertion 
point is on 

Page # of # 
insertion 
point is on. 

 

Distance 
from top of 
the page to 
insertion 
point. 

Line of text 
where the 
insertion 
point is 
located.  

Distance, in 
number of 
characters, from 
left margin to 
insertion point.  

Page of 
document 
insertion 
point is on. 

 

 
 

 

Get Help Using Word 
Word 2003 has a built in help system to give you answers to questions you might have or step by 
step instructions for any given task.  Although there are a variety of ways (toolbar button, menu 
bar, F1) to ask for help in Word, all ways lead to the task pane. 

Help Task Pane 
When you open the task pane in a new document it will always show the 
Getting Started Pane, you know this by looking towards the top of the 

pane it will say “Getting Started.”   

To get to the help pane do the following  

1. Click The small down pointing triangle to the right of the words 
“Getting Started.”  

2. Click  On “Help” 
3. Note The task pane will now look like the picture at right. 
4. Type  A question or topic into the “Search for:” box. 
5. Click  The Green Arrow Button 
6. Note A list of possible solutions to your problem will appear.   
7. Click  On the blue hyperlinks to locate help you need 
8. Next Another window will open that will list instructions for 

accomplishing the task  
9. For Additional help click one of the blue links listed below the 

caption, “Microsoft Office Online.” Help Task Pane 

The part you might find most useful are the icons towards the bottom.   

Assistance: Microsoft office Assistance Page, help with Microsoft products  
Training: Short online courses  
Communities:  A help discussion board  
Downloads: Download updates to software.  Academic Computing does this.  
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Enter Text 

Formatting Marks 
When typing in word there are many formatting marks that are present and you never even 
notice.  Although items such as tabs, spaces and page breaks appear to be invisible, they really 
have special marks that serve as place holders for the spaces.  To see the invisible marks press 

the show hide button on the formatting toolbar.   

Default Typing Options 
Word 2003 has many built in features that will help you as you type.  Many of these things 
happen automatically and you never even realize it. 

1. AutoCorrect fixes common typographical errors, misspelled words and incorrect 
capitalization. 

2. Smart Tags are represented by a lightning bolt button.    
They are usually displayed when Word does something automatically or wants to help 
you in some way.  If you click on the smart tag a list of options relating to the action 
preformed will appear. 

3. Spelling and Grammar mistakes are caught as you type.  Spelling errors are indicated 
using a red wavy line beneath the misspelled word.  Grammar errors are signified with a 
green wavy line. 

4. AutoText inserts common or frequently used text automatically.  For example if you type 
T-U-E-S, Word guesses that you are going to type Tuesday.  When the yellow auto text 
box shows up, press enter and Word will finish typing the rest of the word for you. 

Enter Text 
The main function of Word 2003 is to be a word processor. To enter text: 

1. Click Insertion point into the Text area.  The insertion point is in the text area when the 
mouse pointer changes from an arrow into an I-beam.  

2. Type The text you want to appear in the document. 
a. Press Enter to end a paragraph or to create a blank line between paragraphs 
b. Press Tab to indent the insertion point a half inch to the right. 
c. Press Backspace to delete the character or space to the immediate left of the 

insertion point.   
d. Press Delete to delete the character or space to the immediate right of the 

insertion point. 

Save a Document 

Save As 
The first time you ever save a document you want to use the “Save As” command.  This allows 
you to name your file and say exactly WHERE you want it saved.   

1. Click  File menu. 
2. Click Save As 
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3. A new window will open; “Save As” will be in the title bar (see below). 
4. Select  The location to save your document 

a. Click Dropdown arrow next to “Save in” box 
b. Locate Appropriate drive and folder in which to store the document  

5. Type The name of the document in the File Name Box. 
6. Click Save Button 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Save As Dialog Box 

Save in Box: Choose 
where you would like 
to store a document 

File Name Box: 
Choose what you 
would like to call a 
document 

Creating New Folders 
New Folders can be created while the Save As Dialog Box is open.  

1. Click The Create New folder Button on the Save As dialog box toolbar.  
2. Type  A name for the new folder in the Name text box. 
3. Click OK 

Save an Existing Document 
To save changes to an existing document (one that was previously saved): 

1. Click The Save button on the standard toolbar   
OR Click the File Menu and click save. 
OR Press Ctrl+S keys 

Preview a document 
Often times you may want to preview your document before you print it.  This will allow you to 
catch any major mistakes or make changes before you waste paper in the printing process.   

1. Click  The Print Preview button on the standard toolbar.  
Note: This command is also found under the File menu.  

2. The page will now change to the Print Preview Screen. 
3. Notice the new toolbar at the top of the print preview window.   
4. See the table below for button descriptions. 
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Print Button: Sends the document directly to the default printer.  

Magnifier Button: magnifies the document at 100% or zooms out to 
display one page or multiple pages.  

One Page Button: Displays an entire Page  

Multiple Pages button: Displays more than one page at a time.  

Zoom Box: Displays a list of preset zoom settings or lets you enter a 
specific percentage.  

View Ruler Button: Hides and shows the horizontal and vertical rulers.  

Shrink to Fit Button: Attempts to reduce the number of printed pages print.  

Full Screen Button: Hides the title bar, menu bar and scroll bars.  

Close Preview Button: Closes Print Preview and redisplays the document 
in the previous view.  

Table 2: Print Preview Buttons 

Print a Document 
There are several ways to print your document. 

1. Open The Print Dialog Box.  
a. Click the Print button on the standard 

toolbar.     
b. The document is sent to the printer 

using the default print settings. 
OR Click the File Menu 

Click Print 
OR Press Ctrl + P keys.   

Print Dialog Box 

2. Note The Print Dialog Box is divided into different sections. 
a. Printer:  You can select a different printer, display printer properties, and 

display the selected printer’s status. 
b. Print Range: You can specify exactly which pages you want to print. 
c. Copies: You can select the number of copies you want and whether or not 

they are to be collated. 
d. Print What: You can print the document itself or other document attributes, 

such as its properties or Auto Text entries. 
e. Zoom: Save paper by specifying how many pages will be printed on a single 

sheet of paper. 
3. Set  The desired print options. 
4. Click  OK 
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Navigate in a document 
You may think you already know how to navigate in a document, all you need to do is move 
your mouse right?  Wrong!  By learning to effectively navigate in a document you will see 
yourself being able to accomplish things much faster than you have in the past.  However, first, 
you first need a document to navigate in.   

Open a document 
Display the Open dialog box using one of the following methods. 

1. Press  The Open button on the standard toolbar.  
OR Click the File Menu, Click Open. 
OR Press Ctrl + O keys 
OR Select More in the Getting Started Task pane. 

2. Note The Open dialog box will appear.  See below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open Dialog Box 

Imagine that the computer is a file cabinet.  The “Look in:” drop down box is the “drawer” you 
open to find a particular file or folder. 

3. Double click the icon of the drive or folder to open.   
4. Continue to double click the appropriate folders until you find the document you would 

like to open.   
5. Double click the icon of the document to open it.  

 

NOTE: Icons in the “My Places Bar” on the left side of the window are shortcuts to commonly used 
folders & files.  You can create shortcuts to your personal files by clicking the “Tools” dropdown 
arrow, “add to my places.” 
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Moving In a Document 
Learn to effectively move around in an open 
document. 

Right Arrow One space to the right. 
Left Arrow One space to the left. 
Ctrl+Right Arrow One word to the right. 1. Use the scroll bars on the right and 

bottom of the window.   Ctrl+Left Arrow One word to the left. 
Down Arrow One line down. 2. Click where you would like the insertion 

point to appear 
Up Arrow One line up. 
Ctrl+Down Arrow One paragraph down. 

3. Use the keyboard arrows. Ctrl+Up Arrow One paragraph up.  
4. Try the methods from the table at right. Page Down Down one screen. 

Page Up Up one screen. 

Insert Text Ctrl+Page Down To the top of the next page. 
Ctrl+Page Up To the top of the previous page. 

1. Place the insertion point at the location 
where new text is to be inserted. 

End  To the beginning of a line. 
Home  To the beginning of a line. 
Ctrl+End To the end of the document. 2. Type the new text. 
Ctrl+Home To the top of the document. 

Select Text Table 3: Navigation Methods 

Making changes to a document usually involves using the mouse and/or keyboard to select text 
to be modified.  Try the selection methods described in the following table. 

Method Instructions How to make the Selection 
Place the insertion point at one end of the text you want to select.  Press and hold the 
mouse button.  Move the mouse pointer to the other end of the text; this creates a 
highlighted area (a selection between the two ends.  Then release the mouse button.  
This method is ideal for small selections, such as individual characters. 

Drag over text Drag 

Place the mouse pointer over the word you want to select and double-click the mouse 
button.  Word selects the trailing space along with the word, but not punctuation 
marks. 

Double click 
word Select a word 

Place the mouse pointer over the sentence you want to select.  While pressing Ctrl, 
click the mouse button.  Word selects end punctuation and trailing spaces along with 
the sentence. 

Select a 
sentence Ctrl+click word 

Place the mouse pointer over in the selection bar next to the line you want to select.  
The mouse pointer will change from an I-beam to a right-pointing arrow.  Click the 
mouse button and Word selects the entire line of text. 

Click in Selection 
bar. Select a line 

Place the mouse pointer in the selection bar next to the first or last line of text you 
want to select.  Press and hold the mouse button, and drag down or up to select 
additional lines. 

Drag in selection 
bar 

Select Multiple 
Lines 

Place the mouse pointer over the paragraph you want to select and triple click the 
mouse button.  Word automatically selects the paragraph mark along with the 
paragraph 

Select a 
Paragraph 

Triple click in 
paragraph 

Triple click in 
Selection bar 

Place the mouse pointer over the selection bar and, while pressing Ctrl, click the 
mouse button, or point in the selection bar and triple-click.  (You can also choose Edit 

 Select All, or press Ctrl+A 

Select a 
document Or press Ctrl+A 

Place the insertion point at the beginning of the text you want to select.  While 
pressing Shift, press the desired arrow keys to select just the text you want. 

Select variable 
amount of text Shift and Click 

Make a selection. While pressing shift, press the right arrow key to extend the 
selection one character at a time, or press the Down Arrow key to extend the selection 
on line at a time. 

Extend a 
Selection Shift+  

Make a selection.  While pressing shift, press the Left Arrow key to shorten the 
selection one character at a time, or press the Up Arrow key to shorten the selection 
one line at a time.   

Shorten a 
Selection Shift+  

Select the first item (a line or paragraph, for example), press and hold Ctrl, and use the 
mouse to select any additional items you want. 

Select items 
that aren’t next 
to each other 

Ctrl+drag 

Make another selection, or click the mouse button anywhere in the text area away from 
the selected text. 

Deselect Click elsewhere 

Table 4:  Selection Methods 
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Move and Copy Text 
One of the advantages of using word is the ease in which you can move and copy text to 
different areas of a document or to an entirely different document.   

Move Single selection of Text  
1. Select the text you want to move using the techniques from the previous section 
2. Cut the selected text using one of the following methods. 

Click  the Cut button on the toolbar.  
OR Choose “Cut” from the edit menu 
OR Press  Ctrl + X 
OR Right click and choose “Cut.” 

3. Place insertion point where you want to move the text. 

4. Paste the selection using one of the following methods. 

Click  “paste” on the toolbar.  
OR Choose “Paste” from the edit menu. 
OR Press  Ctrl + V 
OR Right click and choose “Paste.” 

Paste Options 
When you paste a selection of text a small icon will appear 
close to where you pasted your text.  It is called a smart tag 
and usually appears when Word has another question about 
an action you just performed.  When you run your mouse 
pointer over the icon a series of choices will appear.  The 
choices given to you by a Paste Options smart tag are:  

Keep Source Formatting Pastes the item as is, retaining the original formatting so 
the pasted item looks just like it did when it was copied. 

Match Destination 
Formatting 

The copied item’s original formatting is replaced by the 
formatting used at the destination where item is pasted 

Keep Text Only Pastes only item, stripping all formatting that may have 
been copied. 

Apply Style or Formatting Displays the Styles and Formatting task pane. 

Clipboard Task Pane 
In some cases you may want to move many different selections of text to another area of your 
document or to a different document.  This is very easy to do when you use the clipboard Task 
pane.  The clip board serves as a storage area for things that you have cut or copied from a 
document.  To view the clipboard: 

Use the Menus 
1. Click the Edit Menu 
2. Click “Office Clipboard” 
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Move several selections of text  
1. Select the text you want to move. 
2. Cut the selected text. 
3. Repeat steps 1 and area to the clipboard 
4. Place the insertion point where you want to move the text. 
5. In the Clipboard task pane, click the cut item that you want to paste into the document. 
6. Repeat steps 4 and 5 as needed. 

Copying Text 
To copy a selection of text… 

1. Select the text you want to copy 
2. Copy the selected text using one of the following methods. 

Click  the Copy button on the toolbar.  
OR Choose “Copy” from the edit menu 
OR Press  Ctrl + C 
OR Right click and choose “Copy” 

3. Place insertion point where you want the text copied to. 

4. Paste the selection using one of the following methods. 

Click  “paste” on the toolbar.  
OR Choose “Paste” from the edit menu. 
OR Press  Ctrl + V 
OR Right click and choose “Paste.” 

Drag and Drop 
When moving selections of text only a short distance it may be easier to use the Drag and 
Drop method.   

1. Select the text you would like to move. 
2. Click on the selected text holding down the left mouse button, begin dragging it.   
3. Your mouse pointer will turn into an arrow with a small piece of paper.   
4. Move your mouse pointer to the new location of the text. 
5. Release the mouse button 
NOTE:  This same method can be used to copy a piece of text just hold down the Ctrl key 
while dragging.   

Delete Blocks of Text 
1. Select  The text you want to delete. 
2. Delete The text using one of the following methods. 

OR Press Delete. 
OR Press Backspace 
OR Click the Edit Menu, click clear, click contents. 
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Undo Changes 
The undo button is found on the standard toolbar and will help you to quickly and easily undo 
any changes you have made to a document since your last save.   

To undo the most recent change use one of the following methods. 
1. Click  The undo button located on the standard toolbar.  
2. Press  Ctrl + Z 
3. Select  “undo” from the Edit menu  

To undo a series of changes. 
1. Press The drop down arrow next to the 

undo button. 
2. Note All the changes that have recently 

been done are displayed in the order 
in which they were completed. 

3. Drag down to highlight all the changes you would like to undo.  You can not pick and 
choose, the changes you must undo them in the order they were made.  For 
example, in the above figure you could not undo the copy, then the font size, 
then the font color.  You would have to undo the bold, copy, move, etc.   

NOTE: You can redo any change after you have undone it by pressing the Redo button  on 
the toolbar or by pressing Ctrl + Y.  The same rules that apply for undoing multiple 
actions will work with the redoing multiple actions.   

Find and Replace Text 
The find and replace window can be very helpful when you need to quickly locate a certain 
name, place, or other piece of text. 

Find Text 
Display the Find and replace window. 

1. Click the Edit Menu 
2. Click  “Find.” 

OR Press Ctrl+F 
3. In the “Find What” box, type the text you want to locate.  

a. If necessary, set search options. 
b. Click the “More” button to display search options. 
c. Set the desired options. 
d. Click the “Less” button to hide the search options. 

4. Click Find Next to locate the first occurrence of the text in the document. 
5. Continue clicking Find Next to advance to the next occurrence. 
6. When Word has finished searching the document, click OK. 
7. When finished, click Cancel to close the Find and Replace dialog box.   
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Highlight Found Text 
Word 2003 allows you to highlight found text in a document.  In order to accomplish this, all you 
need to do is click on the check box next to the words “Highlight all Items found in:” When you 
click “Find All” word will select all the instances of the text.  If you would like to format it in 
someway you can, just be careful, as soon as you click elsewhere in the text area, your 
highlighting will disappear. 

Replace Dialog Box 

Replace Text 
Display the Replace tab in the Find and 
Replace dialog Box. 

1. Choose  Edit  Replace. 
OR Press Ctrl+H 

2. In the Find What text box, type the 
text you want to locate.   

3. If necessary, set search options by 
clicking the “More” button.   

4. In the “Replace with” text box, type the text that you want to substitute for any found 
occurrences. 

5. Click Find Next to begin the search.  In the document’s text area, Word will highlight the 
first occurrence of the found text.  You can then make one of these decisions: 
a. Click Replace to replace the highlighted text and continue searching for the next 

occurrence.  In this way, you replace selected text on a case-by-case basis. 
b. Click Find Next to leave the highlighted text unchanged and continue searching for 

the next occurrence. 
c. Click Replace All to replace all occurrences of the text at the same time.  Be 

careful—if you use Replace All you can easily make changes you didn’t intend to 
make. 

Use the Thesaurus 
1. Right-click the word for which you want to find a synonym.   
2. A menu will appear, Click “Synonyms.”  
3. A list of similar words will appear; click the one you would like to use.  It will 

automatically be inserted into your text. 
4. You may also go to the full thesaurus by clicking, “Thesaurus.”  It is located at the 

bottom of the list of similar words. 
5. When using the full thesaurus in the task pane it is important to remember that clicking a 

word will give you synonyms to that word.  If you find a word you would like to use, run 
your mouse over the word, a dropdown arrow will appear.  Click the arrow and select, 
“Insert.” 
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Check Spelling and Grammar 
Word will check your spelling and grammar as you type.  If you misspell a word a wavy red line 
will appear under it.  To correct the misspelled word all you have to do is right click your mouse 
on that word, a dialog box will appear containing Word’s guesses as to what you were trying to 
type.  If it is listed, click the appropriate choice and Word will automatically insert the correctly 
spelled word.  

The same procedure will work for grammar mistakes; only instead of a red line Word underlines 
grammar mistakes with a wavy green line.  Right click the word(s) that are causing trouble and 
select the option from the dialog box with the corrected grammar. 

You can also check your entire document using the spelling and grammar checker.   

1. Make sure your insertion point is at the top of your document.   
2. Activate the Spelling and grammar checker using one of the 

following methods. 
a. Click the spelling and grammar button on the toolbar.  
b. Click “Spelling and Grammar” from the “Tools” menu. 
c. Press F7 

3. The first spelling or grammar error is displayed in the Spelling 
and Grammar dialog box.  Indicate how you want to proceed. 
a. Click ignore, to skip the occurrence this time, but find the 

next occurrence.  In this way, you correct found text on a 
case-by-case basis. 

b. Click “Ignore All” to skip all misspellings like this word.    
c. Click “Add To Dictionary” to add the occurrence to the 

dictionary.  This will allow Word to recognize the occurrence as correct. 
d. Click “Change” to replace the found text with the selected correction from the 

Suggestions list box. 
e. Click “AutoCorrect” to have Word make the correction for you. 
f. Click Change All to replace all occurrences of the highlighted text with the suggested 

word at the same time.  Be careful – if you use Change All, you can easily make 
changes you didn’t intend to make. 

4. Click OK to close the Spelling and Grammar checker. 
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Research Task Pane 
The Research Task pane helps you make your document as clear and concise as possible.  It 
contains all the tools that you might need; a dictionary, thesaurus, encyclopedias and it will even 
allow you to search for information on the internet.  To use these tools… 

1. Open the Task Pane 
2. Click the drop down menu at the top. 
3. Select “Research.” 
4. Enter the text or subject you would like to find information on in the “Search for” box.  

If you would like to search all reference books, press enter or press the green arrow.  If 
you prefer to narrow your search to just the dictionary or thesaurus press the dropdown 
arrow next to the text box. 

5. Click on the reference text you would like to use. 
6. Word will automatically direct you to the information you need.   

Check Word Count 
1. Indicate the text that is to be counted. 

a. If you want to count the number of words in a specific piece of text, select it. 
b. If you want to count the number of words in the entire document, do not select any 

text. 
2. Click on the tools menu, choose word count.  The word count dialog box displays the 

counted statistics. 
3. Click Cancel. 

Check Readability Statistics 
Word is able to analyze your document and give you detailed 
information regarding the readability of your writing.  

• Counts: includes the total number of words, character, 
paragraphs and sentences in the document. 

• Averages: the average number of sentences per paragraph, 
words per sentence and character per word. 

• Readability: the percent of passive sentences and 
readability scores based on the number of syllables per 
word and the number of words per sentence. 

Readability Statistics 
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